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Predavanje – Modeliranje 

baze 

  Definicija i osnovni pojmovi baza 
podataka 

 Entitet, svojstvo  

 Relacijski model baza podataka 

 Programi za upravljanje s bazama 
podataka 

 Veze među entitetima 

 Modeliranje podataka 
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Ponavljanje 
• Baza podataka je organizirana zbirka podataka.  

• Relacijski model: podaci organizirani u tablicama.  

• Objekt/događaj koji je predstavljen u tablici zovemo 
entitet. 

• Entitet ima svoja svojstva (atribute).  

• Svako svojstvo treba biti nekog tipa podataka. 

• Redak tablice (zapis, record): sva svojstva nekog 
konkretnog objekta.  

• Stupac (polje, field) u tablici sadrži podatke o 
nekom svojstvu za sve entitete. 

• Primarni ključ – jedinstveno određuje konkretni 
objekt 
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Veze između entiteta 

• Između entiteta mogu postojati tri vrste 
veza 

– Veza 1:1 (jedan-jedan) 

– Veza 1:N (jedan-više, piše se i 1:∞) 

– Veza M:N (više-više, piše se i ∞:∞) 

• Ovisno o tipu veze, vezu realiziramo 

– ili uklapanjem entiteta u drugi entitet  

– ili umetanjem primarnog ključa jednog entiteta 
među svojstva drugog entiteta  

– ili stvaranjem posebne tablice (entiteta) 
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Oblikovanje modela podataka - 

pripaziti 

• Tablice trebaju imati značenje  

– Svaki redak bi trebao predstavljati jedno 

pojavljivanje entiteta 

– Jedna tablica ne bi trebala sadržavati podatke 

o nekoliko entiteta 

• Izbjegava se ponavljanje podataka 

• Olakšavaju se izmjene 

• Različiti stupci za podatke kojima treba 

neovisno pristupati. 

– Ako trebate pristupati samo dijelu podataka u 

nekom stupcu, razdvojite stupac! 
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Oblikovanje modela podataka 

• Pri oblikovanju modela podataka treba 

voditi računa o slijedećem: 

– Koji su entiteti potrebni za funkcioniranje baze 

– Koje upite želimo postavljati na bazi 

– Kakva izvješća želimo imati u bazi 

– Kakve su veze među entitetima 

– Koja su svojstva svakog entiteta 

– Trebaju li se neka svojstva entiteta izdvojiti u 

posebnu tablicu? 
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Oblikovanje modela – još neka 

pitanja 

• Koji su entiteti?   

• Postoje li veze između njih?   

• Kakva je vrsta veze?   

• Postoje li neki dodatni uvjeti?   

• Kakve tablice trebamo za prikaz entiteta? 

• Što je primarni ključ svake tablice? 

• Koja su ostala polja u tablici?  

• Koja polja/tablice trebamo za prikaz veze? 

• Jesmo li nešto zaboravili???  
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Primjer 

• Napravite model podataka za restoran 

koja radi dostave.  

– Potrebno je pamtiti podatke o kupcima, jelima 

koja se dostavljaju te o narudžbama.  

– Moguće je da u jednoj narudžbi bude više 

artikala.  

– Bitno je znati je li narudžba isporućena i koja 

je vrsta plaćanja (gotovina, Visa, Mastercard, 

American)  

• Napravite model (entiteti, veze, primarni 

ključ, tipovi podataka ...)  
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Entiteti i veze 

• Kupac – podaci o naručitelju 

• Jelo – podaci o jelu 

• Narudžba – podaci o narudžbi (opći) 

• Stavke – podaci o djelovima narudžbe 

Kupac - Narudžbe  1 - ∞ 

Stavka - Narudžbe  1 - ∞ 

Stavka - Jelo  1 - ∞ 

Veze 

 

Entiteti 
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Stavka 

 Id Stavka (AN) 

 Id narudžba (N) 

 Id jela (N)  

 Količina (N) 

Model 
Kupac 

 Id kupac (AN) 

 Ime i prezime (T) 

 Adresa (T) 

 Broj telefona (T) 

 Napomena (M) 

Jelo 

 Id jela (AN) 

 Naziv jela (T) 

 Cijena (C) 

Narudžba 

 Id narudžba (AN) 

 Id kupac (N) 

 Datum (D/T) 

 Cijena narudžbe (C) 

 Vrsta plaćanja (T) 

 Isporučeno (Y/N) 
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Zašto smo razbijali ... 

• Puno podataka se ponavlja,  

veća mogućnost pogreške,  

ne možemo prepoznati pravu osobu 
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Access 

• Access – program za upravljanje bazama 

podataka. 

• Podržava relacijski model baza podataka 

• Dio paketa MS Office 

• Zapamtiti: ovisno o načinu rada, nema 

UNDO funkcije. Također, promjene na 

podacima se neprestano spremaju, tako 

da je rizik gubitka podataka malen. 
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Access  

Prozor baze – biramo objekte koje promatramo 

Izbornička traka 

(menu bar) 

Objekti su tablice, upiti, obrasci, izvješća, stranice, makroi i moduli 

Toolbar 
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Access – glavni objekti 

• Tablice (Tables) – služe za spremanje 
podataka. Pomoću tablica reprezentiramo 
entitete iz modela podataka u Accessu. 

• Upiti (Queries) – služe za izdvajanje podataka, 
računanje raznih totala te izmjenu podataka u 
tablicama.  

• Obrasci (Forms) – služe pojednostavljivanju 
komunikacije između čovjeka i baze podataka.  

• Izvješća (Reports) – služe za pripremu izvješća 
koja se mogu prikazati na zaslonu monitora ili 
odštamapati. 
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Temeljni pogledi na tablicu 

• Pogled za oblikovanje tablice (Design 

View) – u njemu dodajemo polja u tablicu 

te mijenjamo razna svojstva polja 

• Pogled za pregled i unošenje podataka u 

tablicu (DataSheet View) – u ovom 

pogledu možemo unositi podatke, sortirati 

ih, filtrirati i slično 
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Design View 

Ikona za prelazak u Datasheet View 
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Datasheet View 
Ikona za prelazak u Design View 

Kretanje po tablici Ukupan broj zapisa u tablici 

Aktivni zapis 
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Tablice – Stvaranje tablica 

• Tablice možemo stvoriti na više načina: 

– U pogledu za oblikovanje tablica (Design 

view) 

– Korištenjem čarobnjaka (by using Wizard) 

– Jednostavnim unošenjem podataka (by 

entering data) 

– uvozom podataka iz neke druge aplikacije 

(File>Get External Data>Import) 
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Prije nego počnemo... 

• Svi programi za upravljanje bazama podataka 

zahtijevaju da za svako polje definiramo tip 

podataka.  

• Naziv polja može biti dug do 64 znaka, velika i 

mala slova se ne razlikuju. 

• Pametno bi bilo izbjegavati dijakritičke znakove 

(č,ć,š,ž,đ) kao i razmake (nije zabranjeno, ali 

mogu nastati problemi) 

• Moguće je da se isti naziv polja pojavi u više 

tablica, ali bi bilo dobro da označava istu stvar u 

svim tablicama (mogući izvor problema).  
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Primjer 

Naziv u modelu 
Naziv u Accessu 

(predloženi) 

Račun Racun 

Ime i prezime 
Ime_prezime ili 

ImePrezime 

• Ukoliko se u nazivima polja pojavljuju č,ć,š,ž,đ 
zamijenimo ih sa c,c,s,z,dj 

• Ukoliko se pojavljuje razmak, zamijenimo ga ili 
podvlakom (_) ili spojimo riječi, ali početak svake 
pišemo velikim slovom. 
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Prilagodite ... 

Stavka 

 Id Stavka (AN) 

 Id narudžba (N) 

 Id jela (N)  

 Količina (N) 

Kupac 

 Id kupac (AN) 

 Ime i prezime (T) 

 Adresa (T) 

 Broj telefona (T) 

 Napomena (M) 

Jelo 

 Id jela (AN) 

 Naziv jela (T) 

 Cijena (C) 

Narudžba 

 Id narudžba (AN) 

 Id kupac (N) 

 Datum (D/T) 

 Cijena narudžbe (C) 

 Vrsta plaćanja (T) 

 Isporučeno (Y/N) 
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Prilagođeno... 

Stavka 

 IdStavka (AN) 

 IdNarudzba (N) 

 IdJela (N)  

 Kolicina (N) 

Kupac 

 IdKupac (AN) 

 ImePrezime (T) 

 Adresa (T) 

 Telefon (T) 

 Napomena (M) 

Jelo 

 IdJela (AN) 

 NazivJela (T) 

 Cijena (C) 

 

Narudzba 

 IdNarudzba (AN) 

 IdKupac (N) 

 Datum (D/T) 

 CijenaNarudzbe (C) 

 VrstaPlacanja (T) 

 Isporuceno (Y/N) 
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Upisujemo polja... 

Upisujemo naziv polja 

Određujemo tip 

podataka Pišemo opis polja. Taj opis 

polja će se pojavljivati u 

DataSheet View-u 
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Nakon što smo sve unijeli... 
Odabir aktivnog polja 

Svojstva aktivnog polja, mijenjaju se ovisno o tipu 
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Postavljanje primarnog ključa 

• Kliknemo na polje za koje želimo da bude 

primarni ključ, nakon toga desni klik mišem i 

odaberimo Primary Key 

 

• Spremite tablicu (File>Save) pod imenom Kupac. 

• Prijeđite u pogled za unošenje podataka (Datasheet 

View). 
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Unos podataka 

• Unesite podatke o slijedećim kupcima: 

– Ivan Ivić, Slavonska 7, 01-2324343 

– Marko Marić, Zagorska 2, 01-4343343 

– Jelena Jelić, Lička 3, 01-4325454 

• Ne trebate ništa pisati u polje IdKupca! 

Oznaka da se zapis promijenio 
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Brisanje zapisa 

• Odaberite prvi zapis (Ivan Ivić) 
Stupac za 

odabir 

zapisa 

• Treba kliknuti u stupac za odabir zapisa, za 
zapis o Ivanu Iviću. Nakon toga desni klik miša 
pa Delete Record. 

Oznaka 
odabranog 
zapisa 
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Unošenje podataka 

• Ponovo unesite podatke za: 

– Ivan Ivić, Slavonska 7, 01-2324343 

 

• Kada nešto počnete mijenjati u zapisu, pojavi se 
olovka u stupcu za odabir zapisa. 

• Dok ste kursorom u tom zapisu promjene nisu 
prihvaćene. Ako Vam se ne sviđaju, kliknite ESC 

• Prelazak kursorom u bilo koji drugi zapis 
uzrokuje spremanje promjene...  

Uočite 

promjenu broja 

u stupcu 

IdKupac! 
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Baze podataka 

• Baza podataka (engl. Database) je organizirani skup podataka pohranjenih 
u računalu namijenjeni radu jedne ili više aplikacija i neovisni o programima 
koji ih obrađuju i može se automatski pretraživati 

• Baze podataka mogu sadržavati upotrebljive sirove podatke (data) (npr. 
popisi zaliha, registri osoba, fizičke osobine materijala itd.), popise mjesta 
na kojima se takvi podaci mogu naći (npr. indeks arhivske datoteke) ili opis 
izvora podataka, posebno bibliografskih opisa dokumenata koji sadrže 
podatke.  

• Relacijska baza podataka je baza strukturiranih podataka koja dozvoljava 
korisniku relacijski odnos između više relacijskih shema koje su međusobno 
povezane ključevima (vezama) 

• Osobine baze podataka: 
– Baza podataka je skup tablica 

– Jedna tablica = jedna relacija 

– Stupci tablice definiraju atribute 

– Vrijednosti atributa jednog objekta unose se u jedan red 



Baza podataka 

 

 

Pasmina Boja  Starost  Ime 

Labrador retriver Smeđa 7 tjedana Fang 

Labrador retriver Smeđa 2 mjeseca Bailey 

Labrador retriver Žuta 8 tjedana Abby 

Labrador retriver Crna 1 godina Shadow 

Labrador retriver Žuta 9 mjeseci Angel 



Baza podataka 

 

 

Objekt promatranja: 

Računar (IBM ThinkPad T43p) 

Svojstva koja možemo bilježiti: 

Procesor  (Intel Pentium M 760, 2.0GHz ) 

Zaslon (15" TFT LCD, UXGA razlučivosti (1600x1200)) 

Veličina hard memorije (60 G) 

Veličina RAM memorije (512 MB) 

Napajanje (Litij-Ionska baterija)  

Težina (2.84kg) 

Dimenzije  (32.9x26.8x3.1cm) 

Komunikacija (IrDA; 56Kbps v.92 fax/ modem; 10/ 100/ 1000 LAN; Intel 

802.11a/b/g, 2.4GHz Ultra Connect Antenna;  Bluetooth) 

 



Baza podataka 

STUDENT 

prezime ime matični broj 

Marković Mirko 12267 
vrijednost 
atributa 

atribut 

Objekt-entitet 



Baza podataka 

• Svojstva entiteta se sastoje od atributa i 

vrijednosti atributa  

• Atribut: element kojim je jednoznačno 

određeno  svojstvo entiteta (ime, prezime, 

JMBG, adresa, visina...) 

• Vrijednost atributa: vrijednosti koje mogu 

poprimiti atributi (Marko, Marković, 

0101985350002...) 

• Podaci o: studentima, radnicima, artiklima, 

prodaji, posudbi knjiga, … 
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Što je MS Access?  

• MS Access je sustav za upravljanje bazama podataka. 

• Što se može napraviti s MS Access-om? 

– Utipkati podatke izravno u bazu podataka ili podatke uvoziti iz drugih 
programa.  

– Sortirati, indeksirati i organizirati podatke na način koji želite.  

– Brzo stvoriti izvještaje i pripremiti ispis naslovnih naljepnica za pisma 
upotrebom svih ili samo dijela podataka.  

– Prilagoditi forme kako bi manje stručni korisnici mogli unositi nove 
informacije u bazu podataka.  

– Stvoriti upite koji će pročistiti vaše podatke ovisno o uvjetima koje 
postavljate.   
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Kako Access sprema podatke?  

• U Accessu je najprije potrebno stvoriti datoteku baze podataka.  

• Tako stvorena datoteka čuva sve što ćete uraditi za tu bazu 

podataka - ne samo sve podatke već i forme, izvještaje i indekse.  



Dijelovi baze podataka 

Tabele (Tables) 

Upiti (Queries) 

Maske (Forms) 

Izvještaji (Reports) 

Stranice (Pages) 

Makro naredbe (Macros) 

Moduli (Modules) 
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Vrste podataka 

• Text  Običan tekst koji može uključivati brojeve, slova i  
 simbole. Polje Text može sadržavati do 255 znakova.  

• Memo Običan tekst kojem niste odredili duljinu, pa stoga  
 praktički nije ograničen u broju znakova (64000   
 znakova). 

• Number Običan broj (ne va1uta ili datum). Access ne dopušta  
 unos bilo kojeg teksta.  

• Date/Time Datum ili vrijeme.  

• Currency Format broja kao valute. 

• AutoNumber Access automatski popunjava slijedne brojeve  
 za svaki slog. 

• Yes/No Odgovor na pitanje. Sadržavati može jednu od dvije  
 vrijednosti: Yes ili No, True ili False ili On ili Off. 

• OLE Object Veza s drugom bazom podataka ili datotekom. 

• Hyperlink Veza s lokacijom na Webu.  

• Lookup Wizard Omogućava stvaranje popisa za odabir  
  vrijednosti iz neke druge tablice ili popisa vrijednosti u 
  kombiniranom okviru za svaki slog. 
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Formati podataka 

• Field Size Najveći mogući broj znakova koje korisnik može unijeti 
  u polje (može se pridijeliti samo polju Text).  

• Format Padajući popis dostupnih formata za određenu vrstu  
 polja. Također, možete stvoriti i korisničke formate.  

• Decimal Places Za polja broja možete podesiti broj decimalnih 
  mjesta koja će se prikazati.  

• Default Value Ako će polje najčešće sadržavati određenu  
 vrijednost (primjerice, za sve zaposlene isti pozivni broj  
 grada), unestite vrijednost uz ovu opciju i uštedjet ćete  
 na vremenu. Vrijednost unesena uz pomoć ove opcije,  
 uvijek se prikazu je u novom slogu i možete je izbrisati  
 i utipkati novu vrijednost kada ona ne odgovara   
 sadržaju.  

• Required Odaberite Yes ili No kako biste Accessu rekli kada ovo 
  polje može ostati prazno kod unošenja novog sloga.  
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Podešenja primarnog ključa  

• Gotovo svaka tablica mora sadržavati barem jedno polje koje ima 
jedinstvenu vrijednost za svaki slog.  

• Takvo jedinstveno identifikacijsko polje nazivamo polje primarnog 
ključa.  

• Ako tablica bude jedna strana relacije jedan-prema-mnogo, tada 
ona mora imati primarni ključ.  

• Accessu morate reći koje polje želite upotrijebiti kao primarni ključ i 
kako bi Access spriječio unošenje istih vrijednosti za više od jednog 
sloga u tom polju.  

• 
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• Iz padajućeg popisa Tables/Queries odaberite tablicu ili upit iz kojih 
želite odabrati polja. (Prema osnovnoj postavci uvijek je odabrana 
tablica koja je na prvom mjestu abecednog reda što vjerojatno nije 
ono što želite.)  

• U popisu Available Fields kliknite polje koje želite uključiti u formu i 
tada kliknite gumb kako biste polje pomaknuli u popis Selected 
Fields.  

• Ponavljajte 4. korak sve dok ne uključite sva polja koja želite u formi. 
Ako želite uključiti polja iz neke druge tablice ili upita, vratite se u 3. 
korak i odaberite neku drugu tablicu.  

• Kliknite Next kako biste nastavili s radom. Bit ćete upitani da 
odaberete izgled: Columnar, Tabular, Datasheet ili Justified. 
Kliknite svaki gumb kako biste vidjeli prethodni pregled određene 
vrste (opcija Columnar je najčešća). Tada kliknite onu koju želite i 
kliknite Next.  
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Slogovi 

• Access sprema svaki unos baze podataka (na primjer, svaki radnik 
ili element inventara) u zasebni redak koji nazivamo slog.  

• Svaki slog (engl. record) je osnovna jedinica baze podataka koji 
sadrži sve podatke definirane u bazi podataka.  

• Slog se dijeli na polja (engl. field). Pojedino polje unutar sloga 
jednog adresara može, na primjer, biti Prezime i ime  

• Svaki detaljniji opis je sadržan u svom stupcu koji nazivamo polje.  
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Veze između entiteta 

• Između entiteta mogu postojati tri vrste 
veza 

– Veza 1:1 (jedan-jedan) 

– Veza 1:N (jedan-više, piše se i 1:∞) 

– Veza M:N (više-više, piše se i ∞:∞) 

• Ovisno o tipu veze, vezu realiziramo 

– ili uklapanjem entiteta u drugi entitet  

– ili umetanjem primarnog ključa jednog entiteta 
među svojstva drugog entiteta  

– ili stvaranjem posebne tablice (entiteta) 
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Forme  

• Svi podaci koje unesete u bazu podataka završavaju u tablici i 
spremni su za spremanje. Pomalo je zamorno i dosadno unositi 
podatke izravno u tablicu, pa stoga većina ljudi stvara posebnu 
formu na zaslonu kako bi lakše unosili podatke.  

• Forma omogućava stvaranje stranice kako biste kasnije unosili 
željene podatke na najjednostavniji način. Access povezuje formu i 
tablicu te informacije koje ste unijeli u formu neposredno sprema u 
tablicu.  









Napraviti Bazu podataka za Studente. Osnovna sredstva su 

Studenti, Fakultet i sva osnovna sredstva koja su vezana za njih. 

To su osnovni podaci za Studente: 

 Ime, Prezime, Datum rodjenja, Pol, Adrese stanovanja, Grad, 

Drzava, Studentski broj, Godina Fakulteta,Predmet i dr.  

Osnovni podaci za Fakultet: 

Naziv Fakulteta, Smjer, Adresa Fakulteta, Kontakt osoba, 

Skolarina, Max. broj studenata na fakultetu i dr. 

 

ZADATAK: 



DIO: TABELE (TABLES) 

Tabela je osnova cijele baze podataka i cuva unesen podatke dok 

je sve ostalo samo uljepsavanje. Tabelu je moguce stvoriti od 

samog pocetka ili upotrebom Table Wizarda. 

 









1.DIO: UPITI (QUERY) 



1.DIO: FORME (FORMS) 
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Izvještaji  

• Dok su forme stvorene za upotrebu na zaslonu, izvještaji se stvaraju 

za ispisivanje.  

• Izvještaji (eng. Report) su posebno formatirani skupovi podataka koji 

su organizirani ovisno o vašoj specifikaciji.  
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Primjer 
• Napravite model podataka za restoran 

koja radi dostave.  

– Potrebno je pamtiti podatke o kupcima, jelima 

koja se dostavljaju te o narudžbama.  

– Moguće je da u jednoj narudžbi bude više 

artikala.  

– Bitno je znati je li narudžba isporućena i koja 

je vrsta plaćanja (gotovina, Visa, Mastercard, 

American)  

• Napravite model (entiteti, veze, primarni 

ključ, tipovi podataka ...)  
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Entiteti i veze 

• Kupac – podaci o naručitelju 

• Jelo – podaci o jelu 

• Narudžba – podaci o narudžbi (opći) 

• Stavke – podaci o djelovima narudžbe 

Kupac - Narudžbe  1 - ∞ 

Stavka - Narudžbe  1 - ∞ 

Stavka - Jelo  1 - ∞ 

Veze 

 

Entiteti 
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Stavka 

 Id Stavka (AN) 

 Id narudžba (N) 

 Id jela (N)  

 Količina (N) 

Model 
Kupac 

 Id kupac (AN) 

 Ime i prezime (T) 

 Adresa (T) 

 Broj telefona (T) 

 Napomena (M) 

Jelo 

 Id jela (AN) 

 Naziv jela (T) 

 Cijena (C) 

Narudžba 

 Id narudžba (AN) 

 Id kupac (N) 

 Datum (D/T) 

 Cijena narudžbe (C) 

 Vrsta plaćanja (T) 

 Isporučeno (Y/N) 
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Zašto smo razbijali ... 

• Puno podataka se ponavlja,  

veća mogućnost pogreške,  

ne možemo prepoznati pravu osobu 


